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1. GETTING STARTED

Please take a moment to familiarize yourself with the text conventions, terms, and controls used in this
User Manual.

1.1 Text Conventions

The examples below explain the specially formatted text used in this User Manual.

» Dialog boxes and control names appear in bold type: Select Member dialog

» Keyboard key names appear in bold type: Home, End, Backspace , Tab

» Keyboard keys that must be pressed at the same time to perform a task appear in bold type with
a plus (+) between the key names: Alt+H

» Drives appear as capital letters: drive C

» File names appear in italics with an initial capital letter: Setup.exe

« Command line statements appear in lower case bold type: a:\install

« Names of icons appear in bold type: My Computer icon

* Menu items, option buttons, and check boxes appear in bold type: Programs , Accessories
Tournament option, Use 18-Hole Factor check box

1.2 Terms

You can use either a single-button mouse or a multiple-button mouse with the Tri-Tees application.

If you have a multiple-button mouse, the left mouse button is the primary mouse button, unless you have
configured it differently. Any procedure that requires you to click the secondary button will refer to it as
“the right mouse button.”

If you have a single-button mouse, pressing the Ctrl key while clicking the mouse button is the same as
clicking the right mouse button.

This User Manual uses the following terms.

Term Meaning

Tri-Tees Name of application.

Press Strike a key from the keyboard.

Type Strike a key from the keyboard to display text

on the screen. Do not press the Enter key
after entry is complete, unless instructed to do

so.
Enter Type the entry, then press the Enter key.
Point Position the mouse pointer until the tip of the

pointer rest on whatever you want to point to
on the screen.

Click Point, press and immediately release the left
mouse button without moving the mouse.

Double-click Point, press and immediately release the
mouse button twice without moving the mouse.

Drag Point and then hold down the mouse button as
you move the mouse.

Choose Click a command button. Click an item from a
menu bar or dropdown menu.

Select Click a command button. Click an item from a

menu bar or dropdown menu. Click an option
button to make a black dot appear. Click a
check box to make an X appear. Click and
item in a list box, then click OK, or double click
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and item in a list.

Clear Click an option button to make the black dot
disappear. Click a check box to make the X
disappear.

In Windows, the terms choose and select have different and specific meanings. Selecting an item usually
means mark it with the selection cursor, which can appear as a highlight, a dotted rectangle, or both. You
also select check boxes and option buttons in dialogs. Selecting alone does not initiate an action.

You choose an item to carry out an action. For example, choosing a command button or menu item
might open a dialog or carry out a command. You often need to select an item before you can choose it.

1.3 Controls

You can use a combination of mouse and keyboard techniques. For example, you could click an item to
select it, and then press Enter from the keyboard to choose it. When a procedure in this User Manual
says to choose an item, generally you can use whichever method you prefer.

This section gives basic information about controls and their functions. Throughout this Guide, the control
name will be in bold type. For example, select OK or select Courses Table check box. The controls
found in the Tri-Tees application are similar as shown below.

Button [1]'4 IWlerm Bar |Ext 4dd Edit Delete Setup
Text Box | | Frame F':'ng saliz |
Cotrho Bozx | Hole-By-Hole j| !

L ]

Icon lw

Option Button. @ First Name [Jahn Smith)
Checlk Box ¥ Couwses Table List Box Oranges

Bananas
Spin Control  [155 4] | Pears

1.3.1 Button or Command Button

You choose a command button to initiate an action, such as carrying out or cancelling a command.
Common command buttons are OK and Cancel. They are often located along the bottom or on the right
side of the dialog.

A command button, followed by an ellipsis (...) or a double greater-than sign (>>) opens another dialog
box.

Unavailable command buttons are dimmed. The currently selected button has a darker border than other
buttons. You can choose the currently selected button, simply by pressing the Enter key.

To choose a command button, click the command button. Or press the Tab key until the button you want
is selected, and then press the Enter key.

1.3.2 Text Box

You type information into a text box. When you move to an empty text box, an insertion point (a flashing
vertical bar) appears. The text you type starts at the insertion point.

If the box you move to already contains text, and the text is highlighted, any text you type replaces it. You
can also delete the existing text by pressing the Delete key or Backspace key.

To select text in a text box, drag the pointer across the text, or double-click a word to select one word at a
time. Or press and hold down the Shift key while pressing an Arrow key.
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1.3.3 Combo Box

A combo box appears initially as a rectangular box containing the current selection. When you select the
down arrow in the square box at the right, a list of available choices appears. If there are more items than
can fit in the box, scroll bars are provided.

To open a combo box and select an item:
1. Click the arrow at the right to see a list of available choices.

2. Click the up or down scroll arrow, if visible or drag the scroll box to move to the item you want to
select.

3. Click the item.

1.3.4 Option Button

Option buttons represent a group of mutually exclusive options. You can select only one option at a time.
If you already have one option selected, your current selection replaces it. The option buttons are,
generally enclosed in a frame. The selected option button contains a black dot. Names of unavailable
options are dimmed.

To select an option button, click the option button.

1.3.5 Check Box

A check box means you can select or clear an option. You can select as many check-box options as
needed. When a check box is selected, it contains an X. Names of unavailable options are dimmed.
To select or clear check boxes, click the check box.

1.3.6 Spin Control

The spin control is a control that works with another control, such as a text box to increment and
decrement values. It can also, scroll back and forth through a range of values or a list of items.

To continue to increment the value, click the up (or right) arrow of the spin control and hold down the
mouse button, then release the mouse button when the desired value is displayed. Likewise, repeat the
latter by clicking the down (or left) arrow to decrement the value. If a flashing vertical bar appears when
you drag the mouse cursor over the area left of the up (or right) and down (or left) arrows, the control
contains a text box. If the area is highlighted or selected you can change the value or list with the up and
down (or left and right) arrow keys from the keyboard.

1.3.7 Menu Bar

The menu bar contains a list of menu items. Some commands carry out an action immediately; others
display a dialog so that you can select options, or a dropdown menu. Dimmed menu items are
unavailable.

A menu item followed by an ellipsis (...) opens another dialog.

1.3.8 Frame

A frame groups the controls together. The name of the frame usually describes the group of controls.

1.3.9 Icon

Icons are small pictures that represent something. For example, the icon in the previous illustration
represents a male. Some icons act as a command button.
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1.3.10 List Box

A list box displays a list of choices. If there are more choices than can fit in the box, scroll bars are
provided so you can move quickly through the list. Some list boxes are accompanied with a text box. If
you type a letter in the text box the list box scrolls to match the letter you type.
Usually, you can select only one item in a list box. There are some cases when you can select more than
one item.
To select a single item from a list box:

» Use the method as described above or

»  Click the scroll arrows until the item you want to select appears in the list

e Click the item, and then choose the appropriate command button or double-click the item to

select it and complete the command all in one step.

To select multiple sequential items in a list, click the first item you want to select, and then drag the cursor
to the last item you want to select.

To cancel the selection, click any item in the list or click the first item you want to select, press and hold
down the Shift key, and click the last item you want to select. Both items, and all items in between, are
selected.

To select multiple non-sequential items in a list, press and hold down the Ctrl key, and click each item
you want to select.

To cancel a selection, press and hold down the Ctrl key, and click the item again.

1.4 System Requirements

The application will operate on the following operating systems and configurations:

* PC with a 266 MHz or greater Pentium-class processor

e Microsoft Windows 95/98/2000/ME/XP/Vista

e« 256 MB of RAM or greater

e 15 MB available hard drive space

e CD drive

e Monitor supporting 800 x 600 or greater resolution with at least 256 colors

Set DPI Setting to 96 DPI
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2.

INSTALLATION AND SETUP

The application must be installed to a hard disk, before it can run. Please look at the appropriate
instructions below.

2.1

Installing from Website

To install application from Golfsoft Software website:

oukrwnNE

2.2

Logon to the Golfsoft Software website (www.golfsoftsoftware.ca).

Click the Tri-Tees hyperlink.

Click the Download Application hyperlink and save to your desktop.
When the download is complete and successful, logoff from the website.
Double-click the TriTeesSetup icon from your desktop.

Delete the TriTeesSetup icon from your desktop.

Installing from CD-ROM

To install application from CD-ROM:

1.
2.
3.

2.3

Turn on your computer and start Microsoft Windows 95/98/2000/ME/XP/Vista.

Place the application CD in your CD-ROM drive.

If AutoPlay is enabled, the installation will begin once the drive closes, follow the on-screen
instructions.

Or

If Auto Play is not enabled, you will need to manually install the application. Double-click the My
Computer icon on your desktop, double-click the icon for your CD-ROM drive, and then double-
click the TriTeesSetup.exe icon. Once the installation begins follow the on-screen instructions.

Uninstalling Application

To uninstall application:

1.
2.
3.

Turn on your computer and start Microsoft Windows 95/98/NT4/2000/ME/XP/Vista.

Click the Start button on the taskbar, point to Settings , and then click Control Panel .
Double-click Add or Remove Programs , select Golfsoft Software Tri-Tees , and then click
Add/Remove to uninstall the application.



GO]fSOft ™ Page 2-2
ssSoftware

2.4 Using Application

Note: Handicap Creator 2011 must be installed on your computer before this application will operate
properly.

24.1 Starting Application

To start the application from the Start Menu , click the Start button on the task bar, point to Programs ,
then Golfsoft Software , and then select Tri-Tees to launch the application.

To start the Tri-Tees application from the desktop , double-click the Tri-Tees icon on your desktop.

To start the Tri-Tees application from the Handicap Creator 2011 application, click the appropriate
command button from the Handicap Creator 2011 opening screen. Refer to the Handicap Creator
2011 User Manual on how to create a Tri-Tees command button.

2.4.2 Start Up

Once the application is started, you should see a window similar as shown below.

startup =

| System Manager Access

| Sign Up

| Hemove

State Farm Insurance Tn-Tees

* E=c Ke
Tl'l_Tees to Eance?r

Click any button,

243 System Manager Access

Click the System Manager Access button to obtain access to the main Tri-Tees application. If the
application is password protected, type in the System Manager password and click the OK button.
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244 Sign Up

To sign up for the event, which has been previously set up by the System Manager, click the Sign Up
button. The response to this button will require users to enter his/her access code. After entering a valid
access code, users will receive a Confirmation window. Click the Yes button.

i

::)- Sign up Francis Mattie
L]

Ewvent: Stake Farm Insurance Tri-Tees
Date; Saturday, Maw 16, 2009

Entry fee: $20.00
Please payv: Pro Shop

Cankinue?

f o |

2.45 Remove

To remove your name from the event, click the Remove button. After entering a valid access code, users
will receive a Confirmation window. Click the Yes button.

zl
€ | Remove Crio Alessio,
\q/

Event: Stake Farm Insurance Tri-Tees
Date: Saturday, May 16, 2009

Remover

: mc.|

2.4.6 Cancel

To exit the Start Up window, click the Cancel button.
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3. MENU ITEMS

The menu bar contains a list of menu items. Some commands carry out an action immediately; others
display a dialog so that you can select options, or a dropdown menu. Dimmed menu items are
unavailable.

A menu item followed by an ellipsis (...) opens another dialog.

To access any of the menu items, click the item or press the Alt key from the keyboard and at the same
time press the underscored letter of the menu item. Some of the menu items have dropdown menu
items.

3.1 File

The File menu item offers commands to 6 dropdown menus:

| File
[ew. ..
Open...
lase
Delete...

Prink Setup. ..

Exit

3.1.1 New

To create a new event, click File|[New... from the menu bar. This opens a New Event window, which
displays the default options of the Tri-Tees event. Set or select the options as required.

NewEvent S
ENER IS vent Unknowy | 2

MHame of Club: |Nulth Granite Ridge Golf Club

Date: | Wednesday, March 24, 2010 P Members Only
Status ]
Gend
B Adults @S & oo Tems  Fighs
% Seniors w T w m 30 =~ 3 -
[ Juniors | -

Ewvent Enty Fee

tember; $0_00 M aon-tember:| $0.00

F'ay:| Pro Shop
Tatal Enllected:l $0.00 | Add | Cancel

Ready ...

Name of Event — This text box allows users to enter the name of the event. The text that you enter here
should describe the event (e.g. Men’s Opening Tri-Tees).
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Date — This is the date of the event. Click the Calendar button, to select the date.

ﬂ March 2008 ﬂ

S5u Mo Tuwe Th Fr 5a

1
2 3 45 6 7 8
9 10 11[12]13 14 15
16 17 18 19 20 21 22
23 24 25 26 27 28 29
30 31

March 12, 2008
Press Enter Kep to Accept or
double click selection box.

Prezs Ezc Key to Cancel

Members Only — This check box determines if non-members can play in the competition.
Status — Select one or multiple options.
Gender — Select one of three options.
Entry Fee
* Member — This text box allows users to enter the entry fee for members.

 Non-Member — This text box allows users to enter the entry fee for non-members.

» Pay — This text box allows users to enter the collector of the entry fee for the competition or
where to pay the entry fee.

Total Collected - This box displays the total amount of money collected for the competition.

Teams — This spin control allows users to set the maximum number of teams that can participate in the
event.

Flights — This spin control allows users to set number of flights.

Click Add button when finished, to accept changes.
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3.1.2 Open

To open an event that has been previously created, click File|Open... from the menu bar. Select the
event from the list and click the Open button.

'—'?1 c:hgolfsoft'tritees

[Holebumber | 1 [(2 [3 4[5 [6] 78 [9]Tot]
| vadage |491]293 361155 310 |389] 147 ] 362 475 2983
[ Pa [STaaflsTaallsals]ss|
Red
[Holehumber | 1 [[2 [3 4[5 [6] 78 [8]Tat]
| ‘vardage |491(293 351 | 125] 300 320] 147] 320 456 | 2813
[ Pa [sTefafslalalsTals[3s]

Blue

[Hole Number | 1 [ 2 [3 [ 4 [5 [6[ 7 (8 (8 [Tt

| Yardege 435232296 101 240 310113 267 4052415
[ Pa [5Tafaf3Talalars 5[]

Do

3.1.3 Close

To close an opened event and return to the main screen, click File|Close from the menu bar.

3.14 Delete

To delete an event from the database, click File|Delete... from the menu bar. Select the event from the
list and click the Delete button.

3.1.5 Print Setup

To set the properties of the default printer, click File|Print Setup from the menu bar.

3.1.6 Exit

To exit the application, click File|Exit from the menu bar.
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3.2 Courses...

To execute the Courses Management application (COURSES.EXE), click Courses... from the menu bar.
See the Courses Management User Manual for instructions.

3.3 Members...

To execute the Members Management application (MEMBERS.EXE), click Members... from the menu
bar.

See the Members Management User Manual for instructions.

3.4 Non-Members...

To execute the Non-Members Management application (NONMEMS.EXE), click Non-Members... from
the menu bar.

See the Non-Members Management User Manual for instructions.
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3.5 Sign Up

To access the Sign Up dialog, click Sign Up... from the menu bar. This dialog allows users to:

e Sign up players.

* Select teams.

»  Print signup sheets to the default printer.

» Set up tee times and print the tee times to the default printer.

e Set or edit starting tees and tee times.

» Execute random starting tee draws for shotgun starts.

e Sort by Team or Starting Tee.

» Handicap Factors can be entered manually or automatically extracted from the database.

e Update Handicap Factors and recalculate Handicaps.

» Players can be exchanged by two clicks of the mouse.

»  Starting tees can be exchanged by two clicks of the mouse.
The Sign Up dialog can be set in several modes: signup, edit, replace and delete mode. Each mode
allows access to different functions. When the dialog first appears, the initial mode is signup.
The third box, displayed in the bottom message area, indicates the current mode. When the mode is
active, the box will blink and display the text of the selected mode; otherwise “No Mode” will be displayed.

Members are displayed in black font and Non-Members in red.

Snup ]
Exit SignUp Edit Replace Delete Print  Done
Team | Flight Player 1 HF | Hcp Player 2 HF | Hcp | Ave HF | Ave Hcp| TotHep| Time Tee

1 A Titterington, Ken 46 4 Jay. Paul 6.1 B h3 L] 10 3A
2 A Roche. Tom 4.7 4 Chisholm, Martin 5.3 5 5.0 5 9 1B
3 A Spinksz, Horman 7.6 i Laporte, Dieter 99 9 8.8 8 16 1A
4 A Ethier, Dave 75 7 Senohrabek. Enc 8.0 ] 7.8 ] 15 4
5 A Chaput. Todd 8.8 ] Hartwig, Tim 9.9 9 9.4 9 17 1B
b A Grozelle. Ron 45 4 Bell. Paul 6.5 B L L] 10
7 A VYerdun, Toban 0.3 1] Miller, D avid 8.2 8 4.3 4 8 5
] B Mutterback. Ed 125 12 Scheuneman. John | 14.6 | 14 13.6 13 26 1A
a B Jamez, Martin 1.2 1 Potter. John 139 13 126 12 24 6
10 B Dlsen. William 13.0( 12 Henson. Steve 13.8| 13 13.4 13 25 3B
11 B Storie, Bob 11.8 | 11 Hewitt, Dave 13.0 | 12 12.4 12 23 9B
12 B McLaren, Robh 1004 | 10 Taylor. Ron 149 | 14 12.7 12 24 3B
13 B Leachman, Dave 125 12 MacHae, Mark 13.6 | 13 13.1 13 25 8
14 B Morrizon, Don 10.8 | 10 Knight, Chng 126 | 12 11.7 11 22 L]
15 C Schlieven, Mike 16.7 | 16 Connelly, Doug 219 21 19.3 19 37 8
16 C Walden, John 16.2 | 15 Lepage. John 22.2 | 21 19.2 18 36 9A
17 C Burton, George 165 | 15 Ross, Don 2000 | 19 18.3 17 34 9B
18 C Gray. Jack 21.7 | 20 West, Fred 303 | 28 26.0 24 48 4
19 C Jovnes, lan 151 | 14 Morrison, Dave 18.2 | 17 16.6 16 | 2
20 C Lee. John 1.0 17 Morris. Peter 190 18 185 18 5 6
21 C Walker, Ray 18.4 | 17 Murphy. Jim 21.1 | 20 19.8 19 7 3A
22 C Alegsio, Orio 16.9 | 16 Potter, Melvin 2h8| 24 21.4 20 40 2

| Ready.. 2009/05/16 | 22 | No Mode System Manager

3.5.1 Menu Items

Exit SignUp Edit Replace Delete Print Done
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3511 Exit

To exit the Signup dialog, click Exit from the menu bar.

3.5.1.2 Sign Up

While in the Sign Up mode, users can:
*  Sign up players.
+ Pick teams.
To set the dialog in Sign Up mode, click Sign Up from the menu bar.

Team Player 1 HF | Hecp Player 2 HF | Hcp | Ave HF | Ave Hep | Tot Hep Time Tee
13> 0.0 0 0.0 0 0.0 0 0 12.00 pm| 1A

The yellow boxes indicate available spots.
To enter the player’'s Handicap Factor manually, check the Ask for Handicap Factor box; otherwise the
application will extract the current Handicap Factor of the player from the member’s database. Handicap
Factors for Non-Members must be entered manually.
To enter a team using the display above:
1. Click the 1>> box.
2. Select each player from the list and click the OK button.
3. Ifthe Ask for Handicap Factor check box is selected, enter the player's Handicap Factor and
click the OK button.
To enter a single player:
1. Click one of the yellow boxes.
2. Select player from the list and click the OK button.
3. Ifthe Ask for Handicap Factor box is selected, enter the player's Handicap Factor and click the
OK button.

When finished, click Done from the menu bar.

3.5.1.3 Edit

While in the Edit mode, users can:

e Update Handicap Factors and recalculate Handicaps.
e Set or edit starting tees and tee times.
» Execute random starting tee draws.

To set the dialog in Edit mode, click Edit from the menu bar.
To update Handicap Factors and recalculate Handicaps:

1. Click the Update Handicap Factors button.

2. To update Handicap Factors and recalculate Handicaps automatically from the member’s
database, click the Yes button; otherwise click the No button.

The dialog is now in the Update Handicap Factors maode.

3. To edit a player’s Handicap Factor, click the box containing the player's name and enter their
Handicap Factor, and then click the OK button or press Enter from the keyboard. The application
will recalculate the player’'s Handicap.

4. When you are finished updating Handicap Factors, click Done from the menu bar.

To set or edit starting tees:
1. Click the box in the Tee column and enter the starting tee and click the OK button or press Enter
from the keyboard.
2. When you are finished setting or editing starting tees, click Done from the menu bar.
To set or edit tee times:

1. Click the box in the Time column and set the tee time and click the OK button or press Enter
from the keyboard.
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2. When you are finished setting or editing starting tees, click Done from the menu bar.
To execute random starting tee draws for shotgun starts:

1. When all the tee names have been entered, click the Draw Tees button several times.
2. When you are finished the random draw, click Done from the menu bar.

3.5.14 Replace

While in the Replace mode, users can:

* Replace players.
* Replace starting tees.

To set the dialog in Replace mode, click Replace from the menu bar.
To replace players, click one player then click the other player.
To replace starting tees, click one tee name then click the other tee name.

3515 Delete

While in the Delete mode, users can:

e Delete players.
* Delete teams.

To set the dialog in Delete mode, click Delete from the menu bar.
To delete a player, click the player and click the Yes button from the Confirmation window.

To delete a team, click the team number in the Team column and click the Yes button from the
Confirmation window.

3.5.1.6 Print
The Print menu item offers commands to 2 dropdown menus.
Prink
Signup Sheet
Tee Times...

To print the signup sheet to the default printer, click Print|Signup Sheet from the menu bar.
See Section 6.1 for print sample.

Page 3-7

To print the tee times to the default printer, click Print|Tee Times... from the menu bar and select the

Format option and click the OK button.
See Sections Error! Reference source not found.  and Error! Reference source not found.
samples.

3.5.1.7 Done

To set the dialog in the “No Mode” state, click Done from the menu bar.

for print
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3.6 Scores

To access the Scores dialog, click Scores... from the menu bar.

Mixed Invitation Alternate Shot

Page 3-8

Exit mdd Edit “ew Skins... Print

HolsMurber |1 |2 13 215617 € |8 Jow|0]i1 12|12 Ji4 15 ]16 |17 [18 ]| In [Grcss [Hep]l Net
Faul Jay [7]  Wendy McCauley [19] &

Team #13 —
5 ra e e T)ra 3 e | a1 e T4 f4 (T4 T4 63 (66|41 |82 [[137] 69 ||
Jamey Larone [7] / Anne Windle [22]

Team #1
e s |asele|s 6|46 |75 3[3[4]6|3|4[5|40] 86 [15] 71

Tearn #4 Faobwarren [1] / Faye Wwarren [19]

[Zlsisfeals]s|s e |43 |e|s|6|44sf2]c]s]43|86 [10] 76
Marman Spinks (3] / Dorathy Spinks [26]

Team #18
[ la s |4 45]a|s e 44|65 6[3]5]6[4|6c|6|4s]88 [17] 71
Tonw McLaughlin (10 / Paula McLaughlin [22]

Team #8

54 e | 46544454 |75 455 [c]z|5]7]|47]| 88 [1&6[ 72

Jelf Brunette [10] / Gemni Brunette [24]

75 |s |4 64|44 646|754 |&5[4[6[4 6565|4490 [17] 73

Terry Smith [13] £ Liza Smith [13)

[ lajsffaa4]afe g4z |s46|a4ef3s|e]s]43]|90 [[13] 77
Bill Butzan [19) / Lois Butson [24]

Team #14
75 |e |4 ee]s(s|7|s0|s|s|4|a4/ef3|c]s]42]|92 2] 70
Todd Chaput [17] ¢ Mabel Chaput [22]

Team #17

(e e el azs|4e|c|a|7s|5=z[alclz|7[7]|47 |92 [17 [ 75

tike Shea [14] / Helen Mcwade [29]

7 s s |4 56|46 |47 666 [3[3]a|4|6l6|46]93 [22] 71

Bob Mecwade (4] / Liahne Shea [34)

7 e s 4 [as]aja[7 446 |s|6|a4af3s]|c|e]50]|94 [[19] 75
Ron Mcwade 5] / Maureen Marrigon [0]

Team #6
[ ls s |4 afels|s 7|48 |76 [6[a4]6(4]c|c|46]94 [3 | 91
Roger Lebrun (12] / Colleen Lebrun [34)

Team #28

(e e fe |46 aj4|5 748|565 |4]alc]s|7|c]|48]| 96 [23| 73

Bob Storie [13] / Barbara Storie [24]

Team #9

Team #29

Team #11

Team &7

Team #16
| & Fa 5 |4 56|56 8|48 6|7 (6|3[4[6|4[7[6]48|36 [[18[77 |~
Skinz  Mormal Sort By Date Teamsz Golfers
|Fieady... | GrossTotal | 2009/07/25 | 29 | 58

This dialog allows users to:

* Add, edit and view team scores.

e Select and edit play-off winner.

* Toggle viewing team skins only or hole-by-hole team scores.

» View total Handicaps, average Handicap or average Handicap Factors.
»  Print team skins to the default printer.

» Print net, gross, net/gross and gross/net scores to the default printer in sorted order.

3.6.1 Menu Items

Exit Add Edit Wiew Skins... Print

3.6.1.1 Exit

To exit the Scores window, click Exit from the menu bar.
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3.6.1.2 Add
The Add menu item offers commands to 4 dropdown menus.
Add
F1 Scramble. ..

Fz alternate Shat.,.
F3 Gross Best Ball. .
F5 all sbove...

To add scramble scores:
1. Click Add|F1 Scramble... from the menu bar
or
press F1 key from the keyboard.
2. Select team from the list and click the Add Score button.

Team #1 - Tom Lornie & Francis Mattie El

|| Scramble m Saturday, March 28, 2009 I
+
Hole Mumber | 1 2 3 4 ] E [ 7 8 9 | Tot
fardage 532 |[415 324 | 376 | 414 | 216 [155 284 182 [[2165 | 1stHine
Par | 5 4 4 3 4 4 [ 3 4 5 36

[ Score I'6 "4 [ 4| 3 [ 3 | 4|2 |3 [4]32|
Score muzst be > 0 and <=19

Ezc Key

to Cancel

Enter

Type zoore for hole number 1.

3. Type the hole-by-hole scores and click the Enter button.
The flashing arrow indicates the hole-score to enter.
To add alternate shot scores:

e Click Add|F2 Alternate Shot... from the menu bar
or
press F2 key from the keyboard.

To add gross best ball scores:
» Click Add|F3 Gross Best Ball... from the menu bar
or
press F3 key from the keyboard.
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To add scramble, alternate shot and gross best ball scores:

1. Click Add|F5 All Above... from the menu bar
or
press F5 key from the keyboard.
2. Select team from the list and click the Add Score button.

Team #1 - Tom Lornie & Francis Mattie il

| Scramble / Alternate Shot / Gross Best Ball m Saturday, March 28, 2009 | 104
3
Hole Mumber [ 1 2 (3[4 |5 [6 [[7 [@ |8 [[Tot {10 11 [12[13 14 [15 |16 17 [18 [ 7ot [19 2021 [[22 23 24 [[25 26 [27 | Tot

Yadage |533415 324376 414 316 ]155(584 |88 ]5165 (215 30 315|245 557 273 95 (253445 (2434 a1 231 (361 [0 212|514 147 | 287 456 |E700
F'3154434434535434454345544344345':5

| Score [[5[44|/3|/3 4234325444 [4]5f4][3 4375|443 4]4(f3]4][4]35]

Score must be > 0 and <= 19

......... to Cancel

Type zoore for hole number 1.

3. Type the hole-by-hole scores and click the Enter button.
The flashing arrow indicates the hole-score to enter.

3.6.1.3 Edit

The Edit menu item offers commands to 2 dropdown menus.

Edit

Tearn Score...
Playoff \Winner. ..

To edit team score:

1. Click Edit|Team Score... from the menu bar

or

press F6 key from the keyboard.

Select team from list and click the Edit Score button.

Edit hole-by-hole scores of the selected team and click the Enter button.

To move the flashing arrow, click the Hole Number area above the hole-score that has to be
changed.

To edit or select the playoff winner:

1. Click Edit|Playoff Winner... from the menu bar.
2. Select playoff team winner from the list and click the Winner button or click Cancel to remove
playoff winner selection.

wn
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3.6.14 View

The View menu item offers commands to 6 dropdown menus.

view
Skins onky
Handicap Eactors
v Average Handicaps
Tokal Handicaps
v Show Scores
Hide Scaores

To view skins only, click View|Skins Only from menu bar.

To view Handicap Factors, click View|Handicap Factors from menu bar.

To view Average Handicaps, click View|Average Handicaps from menu bar.

To view Total Handicaps, click View|Total Handicaps from menu bar.

To hide scores, click View|Hide Scores from menu bar and show scores, click View|Show Scores .

3.6.15 Skins

To add and remove teams playing skins:

1. Click Skins... from the menu bar.
2. Double-click teams from the Not Playing Skins list to add and double-click teams from the
Playing Skins list to remove.

3.6.1.6 Print

| print
[et Scores
Skins Results
Met and Gross Winners. ..
Scorecards, .,

To print net scores, click Print|Net Scores from the menu bar.
Note: The Net option must be set to display the Net Scores menu.
See Section Error! Reference source not found.  for print sample.

To print gross scores, click Print|Gross Scores from the menu bar.
Note: The Net option must not be set to display the Gross Scores menu.
See Section Error! Reference source not found.  for print sample.

To print skins results, click Print|Skins Results from the menu bar.
See Section Error! Reference source not found.  for print sample.
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To print net and gross winners:

1. Click Print|Net and Gross Winners... from the menu bar.
Note: The Net option must be set to display the Net and Gross Winners menu.

2. Set Low Net and Low Gross prizes.
3. Click Apply and then click Print .

See Section Error! Reference source not found.

Print Net and Gross Winners

[ Met

Low Net: | 6 3:

[

Grozs

Low Gross: | 4 3:

X 12t Place Plapaff

Low Met

X 12t Place Playoff

for print sample.

X

Cancel I

 Low Gross

1 |Jame_v Larone / Heather Larone [58)

1 |F|ohin Smith / Patty Hansen [75])

2 |Bi|| James / Sabrina James [B0]

2 |F|oh Warren / Fap Warren [77]

3 |Don Morrizon / Sue Morrizon [61)

3 |Pau| Jay / Maisie Kusluski [78])

4 Paul Fehrenbach / Mary Fehrenb

4 |L|oyd McCauley / Wendy McCauley [78]

5 |N0lman Spinks / Dorothy Spinks [62)

5

Apply

Page 3-12

& [Drval Miller / Shirley Miller (62) 6 |
7| 7|
8| 8|
9| 9|
10| 10|
|F|eady |

To print gross and net winners, click Print|Gross and Net Winners...

1. Click Print|Net and Gross Winners... from the menu bar.
Note: The Net option must not be set to display the Gross and Net Winners menu.

2. Set Low Net and Low Gross prizes.
3. Click Apply and then click Print .

[ Gross

Low Gross: | B 3:

{

Met

Low Net: | B 3:

[* 13t Place Flayaff

Teams:

[ 13t Place Playaff

40

[ Low Gross

[ Low Net

1 |Flohin Smith / Patty Hanszen [75]

1 |Jame_v Larone / Heather Larone [58]

2 |Floh “Warren / Fay Warmen [77]

2 |Bi|| James / Sabrina James [60)

3 |Pau| Jay ! Maisie Kusluski [78)

3 |Don Momzon / Sue Morrizon [61]

4 |L|o_vd McCauley / Wendy McCauley [78]

4 |Pau| Fehrenbach / Mary Fehrenbach [61)

5 |Hoh Troutman / Carrie Dawn Troutman [79)

5 |N0lman Spinks / Dorothy Spinks [62)

[ |Hick Desilets / Liza Smith [79)

B |Dnra| Hiller / Shirley Miller [62]

e

Apply

from the menu bar.

7| 7|

8| 8|

9| 9|

10| 10|
|Heady...

To print scorecards, click Print|Scorecards from the menu bar.

See Section Error! Reference source not found.  for print sample.
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3.7 Zip and UnZip
Zip UnZip
ko Archive fFrom Archive. ..
ko LISE Drive. .. fFrom USE Drive. ..

3.7.1 Zip Files

To zip files to c:\golfsoft\archive\alter.zip :
e Click Zip from the main menu and click to Archive .
To zip files to USB Drive:

e Insert USB Drive into USB port.
» Click Zip from the main menu and click to USB Drive .

3.7.2 Unzip files

To extract files from c:\golfsoft\archive\alter.zip to c:\golfsoft\alter
e Click UnZip from the main menu and click from Archive .
To extract files from USB Drive to c:\golfsoft\alter

e Insert USB Drive into USB port.
e Click UnZip from the main menu and click from USB Drive .

3.8 Help

The Help menu item offers commands to 3 dropdown menus:
Help
G0 ko Galfsaft Saftware \Website

online Manual
about, ..

To go to the Golfsoft Software website, click Help|Go to Golfsoft Software Website  from the menu bar.
To go online and view the Tri-Tees User’'s Manual, click Help|Online Manual from the menu bar.
To learn more about Tri-Tees application, click Help|About... from the menu bar.
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4. COMMAND BUTTONS

You choose a command button to initiate an action, such as carrying out or cancelling a command.
Common command buttons are OK and Cancel. They are often located along the bottom or on the right
side of the dialog.

A command button, followed by an ellipsis (...) or a double greater-than sign (>>) opens another dialog
box.

Unavailable command buttons are dimmed. The currently selected button has a darker border than other
buttons. You can choose the currently selected button, simply by pressing the Enter key.

To choose a command button, click the command button. Or press the Tab key until the button you want
is selected, and then press the Enter key.

After you start a new event or open an old event, the screen will display several command buttons:

Female

The command buttons above are only visible, if the Gender is selected as Male/Female from the Signup
Sheet window (see Section4.4).

4.1 Male

To set the tees for the men, click the Male button.

4.2 Female

To set the tees for the women, click the Female button.

Event Signup Sheet Courses

The Courses button will be disabled, if the Gender is selected as Male/Female. Therefore, select the
course before setting the Gender to Male/Female.

4.3 Event

This command button opens the Old Event dialog, which allows users to edit changes to parameters that
were set during create new event procedure (See Section 3.1.1).

odevent 5

M arme of Event: Mixed Invitation Alternate Shol I 2
MHame of Cluk: |Deep Hiver Golf Club [1972] Inc. [~ Het % Ski
X ns
Ciate of Event: | Saturday, July 5, 2008 HE —
[% Use 18-Hole Factor Draw Enty Fee: I AT
Hour  tinute ) Morring FPF'E of Course
Start Tinne: lﬁ@ lﬁ@ 12:30 pm @® Aftermoon i 18Hole ® 3-Hole
Interval: (10 i ) Eventing
I_E Minutes [ Shotgun Toams: ’TE

Entry Fee for Event

Member:| $30.00 MHon-tember:| $30.00

F'a_l,l:| Pro Shop

Total Collected:)  $0.00 | oK | Cancel

Ready ...
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4.4 Signup Sheet

This command button opens the Signup Sheet dialog, which allows users to determine who can play in
the competition.

Signup Sheet ]

[X:Members Dnly: |' Gender

@ L) C L] D L AR
EIlglt:!'lu.su:lults | rw m ’w w
[% Seniors
[ Juniors | [1].8 | Cancel
Ready ...

Members Only — This check box determines if non-members can play in the competition.
Status — Select one or multiple options.
Gender — Select one of three options.

» Click the OK button, to accept changes.
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4.5 Courses

This command button opens the Courses dialog, which allows users to modify the current course
information, such as: yardage, par or handicap. This dialog also allows users to select the tees of the
home course or select an away course and the tees.

x4

‘Modify Course! Home Courze I
| Deep River Golf Club | 70123 | Away Course |

HoleMumber || 1 || 2 || 3 |[ 4 |[ 5 ([ & [ 7 (& [ 9 || Out Jj 10 (11 [12 [[13 (14 [[15 (16 (17 (18 | In |/ Taot
Tardage (536 |[293 (433 (155 (1371 (1389 || 216 | 362|525 || 3280 (1491 (354 (361|185 310|423 |147 | 421 | 475 || 3167 [|6447
Par |5 4[4 3[4 (a3 |4 (8365|443 (443 (|45]| 36| 7
Handicap 1 (135 (179 || 7 ji15 (11 | 3 2 (&8 (1216 |14 (1018 |[ 4 |[ B

(1] Cancel
|F|eau:|_l,l...

Home Course - Click this command button to select the tees of the home course.
Away Course - Click this command button to select an away course and the tees.

Modify Course - Click this command button to modify the details of the selected course, such as:
yardage, par, and Handicap stroke holes.

45.1 Modify Course

This command button opens the Modify Course dialog, which allows users to modify the course
information such as: yardage, par, and Handicap stroke holes.

Modify Courzse
Front Nine
HoleMumber [ 1 || 2 | 3 [ 4 [ 5 |6 || 7 | 8| 3 |[Tatal
Yardage ||536)(293||4233{155([371) 289|216/ 362 (/525 |[3280 | Cancel I
Par AR E R EEE
Handicap T3 fa|s]afelel|fz2
Back Nine

Hale Mumber | 10 (11 (12 [ 13 |14 [[15 [[ 16 |17 || 18 [ Tatal
Yardage |[491)(1354 || 367 185 |[310)| 423147 (421 || 475 || 3167
Par B4l 44434 e ] 3B
Handicap T4 0epal7alaalgszia:3

Far for hole number 17

» Click the OK button, to accept changes.
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45.2 Home Course

This command button opens the Home Courses Selection dialog, which allows users to select the tees
of the home course.

5
o Courses

Rating/Slope

18-Hale Front Back 3 i o
[69.9]121] [35.0/121] [34.9/121] IDH: | 1 LEEEEEREINES & Y """'
Marme of Course: e il Governor:
| Deep River Golf Club RCGA
Holes™ | Pravince:
’V Ca @3 | Ontario
Hole Mumber || 1 | 2 (3 (4 |5 (6 || 7 (8 || 9 | Out |10 (31 12 )13 |[14 |15 [[16 |[17 (18 | In | Tot
Yardage [ 536||293 (433 (155|371 383 |[216||362 |[525 |[3280 491 (354 |[361 |185 (1310|423 (147 | 421 || 475 || 3167 ||E447
Par 5 (4 43[4 |43 2636 [5[4 (43443 [a|b] 3]
Handicap T 013 (& 179 ([ 7 15 (11| 3 2 |8 (12|16 | 14 |[10 |18 | 4 | B
Yadage 491|231 (361 (1071|312 (314 |[147 | 287 |[456 |[2700 435 (293 |28 || 155 (240|389 (113 | 362 || 406 || 2630 || 53590
Par 15 (3434|432 |63 [5(4 (4|34 [a]3[4a4|]4]35]-70

Handicap [ 1 |15 2 973 |[5 (1217 (I 2 [ 2 10161412012z [ & [N

2 Red/Blue E=zc Key

to Cancel

Ready ...

To select the tees, click the appropriate button displaying the color of the tees or type the number that is
displayed on the button. For example: press the 2 key from the keyboard, if you want to set the tees to

Red/Blue.
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4.5.3

Away Course

Page 4-5

This command button opens the Away Courses Selection dialog, which allows users to select away
courses and tees.

=
* Lizt of Courzes: | Bear Mountain Golf & Country Club - |
. Courses
18-H|:|Ie| | Front Back | “EPET
PXRIT EXGIE EXGIE o#: | 423 43
Mame of Course: S il
HFNEER] EXEY EEIES =
_ _ _ | Bear Mountain Golf & Country Club Holes G .
[68.4[129] [34.27129] [34.27129] P = 1 9 '::ég;r-
64.8 118 f132.4/118 | 32.47118 rovinee!|
HoleMumber [[ 1 [ 2 [ 3 T4 [5 [6 [ 7 [ & |3 [[ou 1031 [12 131415 [16 17 [158 | In | Tot
Vardage | 549|375 (395 |[194 (4593 |[432 {173 |[453 556 || 3650 |64 152 429|488 523 471|189 343 603 [ 3562 |[721 2
Par (5 afallalallallzllaalzalalalasla]zlals]|z:]|z
Handicap |17 (15 [13][3 [1 [3 1[5 F 1248 z106 16154
Vadage | 523|348 [362 183454 |[410155 (443537 |[3421 [[238 135 407 [453 509432 177 [311 567 [ 3323 |67 44
Par (5 afallalallallzllaalzalalalasla]zlals]|z:]|z
Handicap 17 (15 (923 [ (2 (5 7 (M2 725 (2 10 & 1615« |l
Vardage | 508|[325 [329[150( 423|397 148|431 |[521 |[3232 [315 126 |89 [[437 480290 {166 (269 [510 | 3104 |[6336
Par Elalfallalallallzllaalzalzlalalsl4]zals]|z:]|z
Handicap 17 (15 [32 3 [ (25 7 Iz 722 (2 [0 & 1615+ |l
Vadage | 420|325 [323| 88 389|283 {148 |[413 [440|2835 315|116 [389 [[345 464 293 1528 369 [492 [ 3045 |[5883
Par (5 afallalallallzllaalzalalalasla]zlals]|z:]|z
Handicap |17 (15 [13][3 [1 [3 1[5 F 1248 z106 16154
Vardage | 533 |[415[384 [[376 (414|316 {155 |[384 1883165 215 90 |315 345|387 273 | 95 259 (444 [ 2434 |[5593
Par (5 afallalallallzllaalzalalalasla]zlals]|z:]|z
Handicap |17 05 [72 3 [1 [z 115 [ 7 |- 12148 2 [ale [18 18] 4 |-
1 Gold | 2 Blue 3 Black 4 Wwhite 5 Red Esc Key
Search h-"'II to Cancel
| Type the |0 number of the away courze, then press the Enter key...

List of Courses — This combo box allows users to select an away course from the COURSES database.
If the ID number of the course is known, the away course may be select with the Search by button. Click
the Search by button and enter the ID number in the appearing text box.

To select the tees, click the appropriate button displaying the color of the tees or type the number that is
displayed on the button.
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5. DISCLAIMER
5.1 IT IS ILLEGAL TO MAKE UNAUTHORIZED COPIES OF TH IS
SOFTWARE

This software is protected under federal copyright
copies of this software except to make a backup cop
this software for any other reason including for sa
Penalties include fines as high as $50,000 and jail

law. It is illegal to make or distribute
y for archive purposes only. Duplication of
le, loan, rental or gift is a federal crime.
terms up to five years.

5.2 Golfsoft Software Product Warranty

The enclosed software product and users manuals are

all rights. No part of this user manual or any kin

reproduced or translated in any form or medium with

Software.

Golfsoft Software warrants to the original consumer

in this product will be free from defects in materi
receipt). If any diskettes or CDs supplied as part
provided that the consumer purchaser returns the me
the instructions in the following paragraph, Golfso
diskettes or CDs free of charge. This warranty is
this product (dated purchase receipt should be reta

To obtain a replacement diskette or CD, please retu
Golfsoft Software at the address below, accompanied
purchase receipt, your name and return address.

53 Disclaimer Notice

The software, diskettes, CDs and documentation are
merchantability, no warranty of fitness for a parti
either expressed or implied regarding the software,
expressly provided in the preceding paragraph. Acc
the use, results and performance of the software, d
will Golfsoft Software be liable to any person or o
indirect damages resulting from possession, use or
limitation, damage to property and to the extent pe
even if Golfsoft Software has been advised of the p
Under this warranty users agrees that the liability

of legal claim (whether in contract, tort or otherw
suggested retail price for the use of this product.

The terms “RCGA”, “RCGA Handicap Factor”, “Handicap
(N)”, “RCGA Handicap System”, “SLOPE”", “Slope Syste
“RCGA Course Rating”, “RCGA Slope Rating”, “Course

trademarks and service marks. With the exception o
and service marks are the property of the United St

Royal Canadian Golf Association and the Canadian La
system. As owner of the term “RCGA” and a Licensee

service marks, the RCGA has the sole right within i
marks by others.

This software was certified by the RCGA and can onl
associations that issues and maintains RCGA Handica
Handicap System as described in the RCGA Handicap S

copyrighted and Golfsoft Software reserves
d of the accompanying materials may be copied,
out the prior written consent of Golfsoft

purchaser that the diskettes or CDs furnished
als and workmanship (as evidence by your
of this product prove to be defective and
dia to Golfsoft Software in accordance with
ft Software will replace and defective
valid for 30 days following the purchase of
ined as proof of purchase).
rn the diskette or CD only, postage prepaid to
by a statement of the defect, a copy of your

provided “as is”. There is not warranty of
cular use and no other warranty of any kind,
diskettes, CDs or documentation, except as
ordingly, users assumes the entire risk as to
iskettes, CDs and documentation. In no event
rganization for any consequential, special or
malfunction of this product, including without
rmitted by law, damages for personal injury,
ossibility of any such damages or loss.
of Golfsoft Software arising out of any kind
ise) will not exceed the manufacturers

Factor”, “Factor”, “RCGA Handicap Factor
m”, “Slope Rating”, “Handicap Differential”,
Handicap” and “Home Course Handicap” are
f the term “RCGA”, some of these trademarks
ates Golf Association, which has given the
dies Golf Association permission to use the
of those well-established trademarks and
ts jurisdiction to authorize the use of those

y be used by golf clubs or authorized golf
p Factors in full accordance with the RCGA
ystem manual. Golfsoft Software will not in

any way be held accountable for the misuse of this

software.

All elements of this software and user manuals are copyright 1999-2011, Golfsoft Software. All rights
reserved. Box 841, 25 Huron Street, Deep River, Ontario KOJ 1PO.
Telephone: (613) 584-4652 or Cell: (613) 639-9408.
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6. PRINT SAMPLES

The print samples are not actual size.
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Signhup Sheet

Signup Sheet

Tri-Tees Classic
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March 28, 2009

¢ prayer Player 2 ¢ players Player 2
— ] - -
- ] - ]
- ] N ]
- ] W -
- ] - ]
N ] N ]
— ] — ]
N ] - ]
- ] A ]
PR ] - ]
Py ] ] -
Py ] ] -
Py ] Y- ]
Y- ] N ]
R — ] - ]
Y- ] Y- ]
R ] — ]
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Scorecards
1st Nine - Scramble (Yellow Tees) | TEAM lan Joynes (14) Starting Hole
Hole Number 11234 |5|6|7|8]29 Total 9 Holes 19 Dave Morrison (17) 2
Yardage 491(293|361|155|310|389|147|362|475| 2983 .
Par 5443|443 ]4a|5] 36 C Flight
Score
2nd Nine - Alternate Shot (Red Tees) Average Handicap: 16
Hole Number 112 (3|4 |5|6|7 |89 Total | 18 Holes
Yardage 491(293(361(125|300(320(147|320|456| 2813 5796 -
o cTatalatalalslal s 38 - State Farm Insurance Tri-Tees
Score
3rd Nine - Gross Best Ball (Blue Tees)
Hole Number 1 2|13 |4 |5|6 |7 |89 Total | 27 Holes
Yardage 435(232(296|101|240(310(113|287|405| 2419 8215
Par 5|14 |4 |3 |4|4|3|4]|5]| 36 108
Score Golfsoft Software
1st Nine - Scramble (Yellow Tees) | TEAM Bob Storie (11) Starting Hole
Hole Number 11234 |56 |7 ]|8]| 9| Total | 9Hales 11 Dave Hewitt (12) gB
Yardage 491(293(361(155|310(389|147|362|475| 2983 .
Par 54|43 |4|4]|3|4]|5] 36 B Flight
Score
2nd Nine - Alternate Shot (Red Tees) Average Handicap: 12
Hole Number 1 2|13 |4 |5|6 |7 |89 Total | 18 Holes
Yardage 491(293|361|125|300(320|147|320|456| 2813 5796 -
oo s T2 TaT3 a2t als 36 — State Farm Insurance Tri-Tees
Score
3rd Nine - Gross Best Ball (Blue Tees)
Hole Number 11234 |5|6 |7 |89 Total | 27 Holes
Yardage 435(232(296|101|240(310(113|287|405| 2419 8215
Par 5144|3443 4|5 386 108
Score Golfsoft Software




6.3 Scores
State Farm Insurance Tri-Tees A Flight
Hole 1 2 3 4 5 6 7 8 9 & 10 11 12 12 14 15 16 17 18 AS
Yardage 491 293 361 155 310 389 147 362 475 2983 491 293 361 125 300 320 147 320 456 2813 435 232 296 101 240 310 113 287 405 2419
Par 5 4 4 3 4 4 3 4 5 36 5 4 4 3 4 4 3 4 5 36
1 Team #7 - Toban Verdun and David Miller (Handicap = 4)
4 3 3 3 4 2 3 3 4 29 6 4 4 3 3 3 3 5 5 36
2 Team #6 - Ron Grozelle and Paul Bell (Handicap = 5)
4 3 4 2 3 4244 30 6 45 3 44 3 5 4 38
3 Team #5 - Todd Chaput and Tim Hartwig (Handicap = 9)
5 3 3 3 3 4444 33 6 45 3 44 2 45 37
4 Team #1 - Ken Titterington and Paul Jay (Handicap = 5)
5 4 3 3 3 4 3 3 4 32 446 2 356 3565 37
5 Team #2 - Tom Roche and Martin Chisholm (Handicap = 5)
4 3 4 3 4 4 3 44 33 645 35 4 355 40
6 Team #4 - Dave Ethier and Eric Senohrabek (Handicap = 8)
5 35 3 44444 36 6 4 3 43 43515 37
7 Team #3 - Norman Spinks and Dieter Laporte (Handicap = 8)

543245445 36 5453553486 40
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Saturday, May 16, 2009

19 20 21 22 23 24 25 26 27 GBB

5 4 4 3 4 4 3 4 5 36

4 3 43 3 3 3 3 4 30

4 3 3 3 4 4 3 4 4 32

54 3 2 3 4354 33

7 3 4 3 44 2 43 34

44 4324344 32

5 3 5 3 443 44 35

Total
8215
108

95
100
103
103
105
108
108
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